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Introduction

This tutorial is the open sourcing of the foundational
material needed to create an audio-based project
using the Zybo Z7-10 FPGA. The software used
throughout the project include Xilinx’s 2018.2.1
Vivado and Vivado SDK. This tutorial was made for
those who seek to create FPGA projects with audio as
a main focus. The tutorial is divided into two main
parts, Xilinx Vivado and Vivado SDK, and a third minor
part, SD Boot. The main parts each deal with the two
main software used in establishing the project that
the user will need to use. The third part is included as
a supplemental piece in order to finalize the project
and run it on its own. In the process of creating the
sample project that is presented here, the author
found many different sources to pool information
from but still spent a lot of time to get everything
together and in working order. There existed no easy,
step-by-step tutorial for the basic platform of
manipulating audio samples on the Zybo FPGA. Thus,
as part of the Open-IC team, which seeks to create
and sustain platforms for projects that use FPGAs, the
author here has created this basic tutorial on building
an audio platform on the Zybo Z7.

Though this tutorial is made for novices and
beginners with little to no experience using Xilinx
Vivado, this tutorial is not meant to teach the Xilinx
software. This tutorial’s focus is on preparing the
audio platform on which the end user may create
their own program to run on the Zybo Z7 FPGA. For a
more thorough guide on the software itself, the
author recommends the Zynq Book tutorials which
can be found on their website:

Dependencies

This tutorial has many file dependencies that the user
must download onto their computer. The Zybo Audio
Control IP used in this project comes from the Zynq
Book project website linked previously. The Vivado
software also requires Digilent’s board files for the
Zybo Z7-10 which can be found on their Github:

Pin designations require the use of Digilent’s Master
Constraint File also located on their Github:

Specifics on where to place these files are included in

the tutorial, but having the files downloaded prior to
beginning will help the user in following along with
the tutorial. Of course, this being a tutorial for the
Zybo 77-10, the user should also have the FPGA:
which can be bought at the Digilent online store.
Other necessary hardware will include a microphone,
and a musical instrument for testing the included
project reference. The microphone the author used in
this project was the PoP Voice Lavalier Lapel
Microphone found on Amazon. The author also
recommends an instrument that can play complex
chords, like a guitar or piano, in order to properly test
the chord detection algorithm included in the tutorial.

In closing, the author would like to thank the group
that supported the full project, of which only the
FPGA part is present here. The University of Houston
Clear Lake 2019 Senior Project group consisted of
Mitchell Jefferies, Rigo De Leon, and Harold Mao, as
well as the author. The author would also like to
thank Dr. Xiaokun Yang, the mentor for the senior
project, as well as the head of the Open-IC project.




Xilinx Vivado

We begin this project by launching Xilinx Vivado
2018.2.

Under Quick Start, we will proceed by clicking on
Create Project.

VIVADO'

HLx Editions

Quick Start

Create Project »
Open Project >

Open Example Project >

This will open the New Project window. Click on Next.

Create a New Vivado Project

VIVADO!

HLx Editions This wizard will guide you through the creation of a new project.

To create a Vivado project you will need to provide a name and a location for your project files. Mext, you
will specify the type of flow you'll be working with. Finally, you will specify your praject sources and
choose a default part.

& AEINA

(:'D = Bac MNext = Finish

For this tutorial, we will name the project, “audio
example.” Be sure to note where the project location
is, and ensure that the “Create project subdirectory”
option is checked. Click on Next.

¢ New Project X

Cancel

¢ New Project X

Project Name

Enter a name for your project and specify a directory where the project data files will be stored. '
Projectname: audio_example
Project location: D:/Documents/VivadoProjects II‘

Create project subdirectory

Project will be created at: D:/DocumentsiVivadoProjects/audio_example

The project type will be an RTL Project, and no
sources will be specified at this time. Proceed with
Next.

¢ New Project x

Project Type
Specify the type of project to create. '

o RTL Project
You will be able to add sources, create block designs in IP Integrator, generate IP, run RTL analysis, synthesis,
implementation, design planning and analysis.

Do not specify sources at this time

Post-synthesis Project: You will be able to add sources, view device resources, run design analysis, planning and
implementation.

110 Planning Project
Do not specify design sources. You will be able to view part/package resources.

Imported Project
Create a Vivado project from a Synplify, XST or ISE Project File.

Example Project
Create a new Vivado project from a predefined template.

The next step will require the board files for the Zybo
Z7-10 FPGA.

NAVIGATE TO THE DIRECTORY WHERE XILINX VIVADO WAS
INSTALLED. BY DEFAULT, IT INSTALLS DIRECTLY INTO THE C DRIVE.
THE “zYB0O-27-10" FOLDER WHICH CONTAINS THE BOARD FILES
FOR THE ZYBO FPGA SHOULD BE COPIED INTO:
“NXILINX\VIVADO\2018.2\DATA\BOARDS\BOARD_FILES”




On the window in Vivado, select the “Boards” tab,
and search for the Zybo-Z7-10 board files you have
downloaded. Proceed with Next.

¢ New Project *

Default Part
Choose a default Xilinx part or board for your project. This can be changed later. '

Pars | Boards

Reset All Filters

Vendor: | All ~ MName: | All ~ Board Rev: | Latest ~
Search: Zybo ~ | {1 match)
Display Name Preview Wendor File Version Part
Zybo Z7-10
digilentinccom 1.0 uCT2
< >

(=) .

The last page on the window will show a summary of
all of the project settings chosen. Compare with the
included image.

¢ New Project X

New Project Summary

VIVADO'

HLx Editions
! . © AnewRTL project named "audio_example’ will be created.

ﬁ The default part and product family for the new project:
Default Board: Zybo Z7-10
Default Part: xc7z010clg400-1
Product: Zyng-7000
Family: Zyng-7000
Package: clg400
Speed Grade: -1

£ XILINX

To create the project, click Finish

-
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We will begin by creating a new Block Design. You
may leave the default Block Design name. Press OK.

¢ audio_example - [D:/Documents/VivadoProjects/audio_example/audio_example.xpr] - Vivado 2018.2.1

File  Edit Flow Tools Reports Window Layout View  Help Quick Access

&, ~ I 2>
Flow Navigator F e B PROJECT MANAGER - audio_example
v PROJECT MANAGER
Sources ? 00X Project Summary
£} Settings
> A
Qa = £ 4+ o
Add Sources Settings Edit
Design Sources
Language Templates -
=g P > = Constraints Project name:
<F IP Catalog + = Simulation Sources Project location:
sim_1 Product family.
v |PINTEGRATOR Project part:
Create Block Desian Top module name

Open Block Design Targetlanguage:

Simulator language:
Generate Block Design

v SIMULATION Board Part
Run Simulaton | o o 2
un Simulation Hierarchy = Libraries  Compile Order DS 2
Board part name: d
v RTLANALYSIS TS 2 _ 0@ X Connactors: r
> Open Elaborated Design u‘ Repaository path c
URL: h
¥ SYNTHESIS Board overview: Z
P Run Synthesis
> Open Synthesized Design Synthesis
Select an object to see propertie Status: No
~ IMPLEMENTATION lect an objectto see properties
Messages Mo

P Run Implementation

Vivado should present you with this window:

Diagram ?-0aX

This design is empty. Press the = button to add IP.

Click on the large + to begin adding IP blocks.

Search: |

.

T 1612 5G Ethernet PCSIPMA or SGMII
¥ 2D Graphics Accelerator Bit Block Transfer
3GPP LTE Channel Estimator
3GPP LTE MIMO Decoder
3GPP LTE MIMO Encoder
3GPPLTE Turbo Encoder
AGPP Mixed Mode Turbo Decoder
3GPP Turbo Encoder
™ 10G Ethernet MAC

© Accumulator -
EMTER to select, ESC to cancel, Cirl+L1 for IP details

The first block we will be adding is the Zynq
Processing System.

Diagram
by O + = * C
IP Details x
Search: Zyng| (1 match)
7 ZYNQ7 Processing System Mame: ZYNQT Processing System
Version: 55 (Rev. B)

Interfaces AXl4, AX14-Stream

Description:  Arm dual core SOC with Zynq fpga
Status: Production

License: Included

Change Log: View Change Log

Vendor: Xilinx, Inc. P
VLNV: xilime.com:ip:processing_system7:5.5
ENTER to select, ESC to cancel, Cirl+Q for IP details Repository: C:l¥ilinx/Vivadoi2018.2/datalip -

Double click on the IP to add it to your workspace.

A banner should appear stating, “Designer Assistance
available. Run Block Automation.”

Click on “Run Block Automation.”

Diagram ? _0ax
Q w0 Q + ® oA Cly o

¥ Design ice available. Run Block Automation

processing_system7_0

DoR + |||
- FIXED_IO + |||
M_AXI_GPQ_ACLK ZYNQ M_AXI_ GPO + £

FCLK_CLKO
FCLK_RESETO_N

ZYNQ7 Processing System




Leave all options as default. Press OK.

¢ Run Block Automation *

Automatically make connections in your design by checking the boxes ofthe blocks to connect. Select a block on the left to display its
configuration options on the right. '

Q - -
= -

~ & All Automation (1 out of 1 selected)

Description
This option sets the board preset on the Processing System. All current properties will be
overwritten by the board preset. This action cannot be undone. Zyng7 block automation

applies current board preset and generates external connections for FIXED_IO, Trigger
and DDR interfaces.

+ ¥ processing_system7_0

MOTE: Apply Board Preset will discard existing IP configuration - please uncheck this box,
if you wish to retain previous configuration.

Instance: fprocessing_system7_0
Options

Make Interface External: FIXED_IO, DDR

Apply Board Preset: +

Cross Trigger In: Disable ~

Cross Trigger Out: Disable ~

(3
N

The results should be two external pin connections to
the Zynq Processor IP block.

¥ #,/Clu o o

processing_system?_0

DDR + |||===["> DDR
FIXED_IO + |[|==> FIXED_IO

N Il
moaxaroActk 7\N|() M_AXLGPO +[5
FCLK_CLKO

FCLK_RESETO_N

ZYNQ7 Processing System

The next step requires the IP block for the Zybo Audio
Control IP.

OPEN THE SOURCE DOWNLOAD ZIP FILE
“THE_ZYNQ_BOOK_TUTORIAL_SOURCES_AUG_15.zIP”
DOWNLOADED FROM THE ZYNQ BOOK WEBSITE. NAVIGATE TO
“SOURCES\ZYBO\ADVENTURES_WITH_IP_INTEGRATOR\IP\”
AND EXTRACT THE ZIP FILE
“XILINX_COM_ZYBO_AUDIO_CTRL_1.0.zIP” TO YOUR DESKTOP.
NAVIGATE TO YOUR VIVADO INSTALL DIRECTORY AND CREATE
THE FOLDER “\DROPIN” AT
“NXILINX\VIvaD0o\2018.2\pATA\IP\”

EXTRACT THE SOURCE |P FOLDER INTO THE NEWLY CREATED
“DROPIN” FOLDER WITH A FINAL PATH OF:
“NXILINX\VIVADO\2018.2\DATA\IP\DROPIN\XILINX_COM_ZYB
O_AUDIO_CTRL_1.0”

We will now add an IP repository to our project to
point Vivado towards our included IP files. On the
Flow Navigator to the left, under PROJECT MANAGER,
click on Settings.

¢ audio_example - [D:/Documents/VivadoProjects/audio_example/audio_

File Edit Flow Toaols Repors Window Layout View Help
=, W - ® & b, W B T

Flow Navigator - A BLOCK DESIGN - design_1*

v PROJECT MANAGER ) )
Sources Design »  Signals Boai

Q = A

design_1

£} Settings

Add Sources

Language Templates
> External Interfaces

L+ IP Catalog > Interface Connections
» 7F processing_system7_0 (ZYNO7 Proc
¥ |IP INTEGRATOR

Create Block Design
Open Block Design

Generate Block Design

»  SIMULATION

Run Simulation
Navigate to Project Settings > IP > Repository

| # Settings X |

Q,
IP > Repository

Project Settings Add directories to the list of repositories. You may then add additional IP to a selected y

General repository. If an IP is disabled then a tool-tip will alert you to the reason

Simulation T
Elaboration IP Repositories
Synthesis +
Implementation
Bitstream
o Mo content
Repository

Packager

Tool Settings Refresh All

Project
IP Defaults
Source File
Display
WebTalk
Help
» Text Editor
3rd Parly Simulators
> Colors
Selection Rules
Shorcuts
» Strategies

» Window Behavior

L |
o ] [ower ]

Click on the + sign. This will open a browsing window.
Search for the folder in which we saved the Zybo
Audio Control IP. In our case, we saved it to
“NWilinx\Vivado\2018.2\data\ip\dropin”

¢ IP Repositories x
vitodit, dOX=RZC

Recent: ClXilinwVivado/2018.2/datafip/dropin

Directory: | C:WilinkVivado\2018 2\datavip\dropin

e dropin ~
> xilinx_com_zybo_audio_ctrl_1.0

> interfaces

> partners

> xiliny

> xpm

licenses_op

memaory

msg

mtbf

osci_systemc

parts

precomp

precomp_hsv

pubkey

rsb

rulecheck

sdx

secureip

system_verilog -

VWOV W W W W WV W W W W v




Click on the “dropin” folder and click Select. This After the connection automation is complete, click on

should add the repository to the project which the “Regenerate Layout” button to clean up the
includes the “zybo_audio_ctrl” IP. window. The results should be similar to this:
¢ Add Repository % "C;“;“’“'; v w e e s PR > o n;
o 1 repository was added to the project rLPS7.0_50M 7 0. axt_parish
::’w:e(“:nm < bus_struct ;‘;:ﬂrleﬂsz: : ﬂ S00_AXI
@ aux_resel_in ‘ peripheral_reset[0:0] fm . ACLK —m 2ybo_audio_ctrl_0
. : ::md:j:»:;sys . peripheral . :zuE iEcTL’j( lil MOO_AXI + [ |4 s aa BCLK
Repository Prteeto Syt e i e D TP
= v cHilingVivado/2018 2/datafip/dropin (] D — S e
processing_system?_0 AXI Interconnec T Zybo_audio_ctrl
e v |Ps (1) DR + || > DOR
i . T, I, FIXED_IO +|| [ FIXED_IO
zybo_audio_ctrl (xilimx com:xilinxzybo_audio_ctrl:1.0) M AKI PO ACLK ZYNQ‘ e il
S
ZYNQ7 Processing System

The IP should be added to the repository. Click on OK, The Zybo FPGA’s SSM2603 Audio Codec requires an
click on Apply, and close the settings window. enable signal to function. Our project will need the
codec always on, so we will add a ‘constant’ IP block

We should now be able to search for and find the to drive the signal high.

o Q ” -
N IP Details 4
zybo_audio_ctrl” IP block. somrch 1. consta ct maem [
Constant | MName: Constant
IP Details. X P
Search: zybo_audio_ctrl {1 match) Version:  1.1(Rev.5)
2ybo_audio_ Mame: zybo_audio_ctrl Description: Gives a constant signed value.
Version: 1.0 (Rev. 4) Status: Production
Interfaces:  AXl4 _' License: Included
Description: 125 based audio codec on ZyBo board Change Log: View Change Log
Status- Production Vendor: Xilinx, Inc.
) WLINW: yilinx.com:ipxiconstant 1.1
License: Included

Vendar XUP Repository.  CuXilingVivado/2018.2/datalip

WLMY: silimk.comuxilingzybo_audio_ctrl:1.0 EMTER to select, ESC to cancel, Ctrl+C for IP details

Repository.  ciXilinxVivado/2018.2/datalip/dropin

ENTER to select, ESC to cancel, CiteQ for P detalls || | Double clicking on the ‘Constant’ IP block will allow us
to adjust its settings.

Double click on the IP, and run the connection /' Re-customize I x
automation again. This should connect the IP block Constant (1.1 p
S_AXI connection to an AXI Interconnect which is © Documentation = 1P Locaton

then connected to the ZYNQ7 Processing System.

¢ Run Connection Automation > o immes

Automatically make connections in your design by checking the boxes of the interfaces to connect. Select an interface on the left to display its ConstVal 1
configuration options on the right.

Q z < Description
~ /] All Automation (1 out of 1 selected) Connect Slave interface (fzybo_audio_cirl_0/S_AXI) to a selected Master address space
~ /| ¥ zybo_audio_ctrl_0 dout[0:0]
v S_AXl Options
Master
Bridge IP

Clock source for driving Interconnect P | Auto
Clock source for Master interface Auto

Clock source for Slave interface Auto

4 >

Ensure both settings are set to ‘1’, and click on OK.




We will now configure the ZYNQ7 Processing System.

Double-click on the IP block for the PS.

¢ Re-customize IP X
ZYNQ7 Processing System (5.5) /
0 Documentation ﬂ- Presets IP Location 'ﬂ' Import XPS Settings

Page Navigator - Zynqg Block Design Summary Report

Zynqg Block Design i

" SPIO Settings Application Procassar Unit (APU!
PS-PL Configuration e o e

"o | e
{15:0) 2C 1
Peripheral /0 Pins — e .
CAN 1 — Con
MIO Configuration UART O
e LART 1 L1
e S ¥ 1 ok Sneop Centrol unit
Clock Configuration M0y SD0 | v
-i 41 so1 Channel 512 KB L2 Cache and Controlier

™
ARM Cortex -48

CPU cPU

ARM Cortex -A9

TEE

USB0
DDR Configuration USB 1 ocM

ENETO N | b | ||[CoeSignt || |interconnect 5R »
—_—
ENET 1 entral Components
SMC Timing Calculation Banki | | T=——————— | interconnect $

MO FLASH Memory ‘ T
{53:18) Interfaces DAP |

Interrupts <4 5”-’“‘" IR Memory interlaces
<=l
OLIADSP . DEYC ng(ammabl DDF23LP|DFZ
— ‘o Memory
aeming | |l [T | | | Ltnewcomed
Calcutation
DuA ETTRE]
NN mm
Gheg [ e [ | Processing Syslem(PS)
Rassis | | cenerston A

ol zial, 1 I EL I s | s

PEPL

MID (EMIO) Xl
Clock Porta Master

Pors

24a

Programmable Logic(PL)

There are two things we must configure for this
project. First, we must activate an I12C connection on
the processor in order to write to the audio codec’s
registers. Secondly, we need to create a new clock to
drive the audio codec.

To create the I12C connection, we will navigate to the
“Peripheral I/O Pins” page on the left-hand Page
Navigator. Scroll down to find the ‘12C O’ peripheral
and ensure that the box is checked.

ZYNQT Processing System (5.5) '

@ Documentation  £F Presets IP Location ¥ Import XPS Settings

Page Navigator - Peripheral /O Pins Summary Report
Zynq Block Design « Q T = ©0
PS-PL Configuration Search:
Peripheral i0 Pins Bank0 | LVCMOS 3.3V v Bank1 | LVCMOS 1.8V v
Peripherals 0 1 2 3 4 5 8 7 8 9 10 11 12 13 14 15 18 17 18 19 20 21 22 23 24 325
MIQ Configuration usB 1 .
Clock Configuration > sDo so0
DDR Configuration >L/8D1 so1 so1
> sPID
SFI0
SMC Timing Calculation -
> sAn SPI4 SPIt
Interrupts
> UARTD UARTO UARTO UARTO UARTD
> /] UART UART1 UART1 UART1 UART1 UART1
11260 120 1260 120 12G0
12c1 12c1 12c1 12c1 12C1
’ CAN1 CAN1 CAN1 CAN1 CAN1 CAN1
TTCO
TTCO .
TTCA < >

¢ Re-customize IP X

Scrolling all the way to the right should show EMIO
highlighted in green for the 12C connection.

For the clock configuration, click on “Clock
Configuration” on the Page Navigator. Click on the
drop-down arrow for ‘PL Fabric Clocks.” Check the box
next to ‘FCLK_CLK1’ and type “12.288” under
‘Requested Frequency.’

+  Re-customize IP X
ZYNQ?7 Processing System (5.5) /

© Documentation £¥ Presets IP Location ¥ Import XPS Settings

Page Navigator - Clock Configuration Summary Report
Zynq Block Design Basic Clocking  Advanced Clocking
PS-PL Configuration Input Frequency (MHz)| 33.333333 CPU Clock Ratio 6:2:1 v
Peripheral 110 Pins « O T =2
MIO Configuration Search

Component Clock Source Requested Frequ... Actual Frequency(.. Range(MHz)
Clock Configuration

3 ProcessorMemory Clocks
DDR Configuration » 10 Peripheral Clocks

~ PLFabric Clocks
SMC Timing Calculation

~'| FCLK_CLKD I0PLL ~ |50 50.000000 0.100000 : 250.000000

Interrupts ~| FCLK_CLK1 I0PLL ~ 12288 0.100000 : 250.000000
FCLK_CLK2 10 PLL 50 10.000000 0.100000 : 250.000000

FCLK_CLK3 10 PLL 50 10.000000 0.100000 : 250.000000

> System Debug Clocks

> Timers

Do note that the ‘Actual Frequency’ will be different
than the requested frequency.

Press OK to close the ZYNQ7 Processing System IP
customization window. Two new connections should
appear on the ZYNQ7 IP Block: ‘lIC_0’ and
‘FCLK_CLK1'.

Diagram ?_0aAX
@ a X B o Q s |+ = » C d9 ¢ o
rst_ps7_0_50M
ps7_0_axi_periph
lowest_sync_clk mb_reset (= ¥
ext_reset_in bus_struct_reset[0:0] jm peeii| + S00_AXI
< awx_reset_in peripheral_reset[0:0] H ACLK zybo_audio_ctrl_0
= mb_debug_sys_rst ARESETN .Y. r
= dem locked peripheral . S00_AGLK HW MO0 AXI + i 2+ s_AXI BCLK
I SDO_ARESETN giig RECDAT PBLRCLK
Processor Syslem Reset - MOD_ACLK S_AXI_ACLK RECLRCLK
- MOO_ARESETN S_AXI_ARESETN PBDATA
processing_system7_0 AXI Interconnect 2ybo_audio_ctrl
DDR + [ DDR
FIXED_IO + [ FIXED_IO
nco + xlconstant_0
- USBIND 0 +
M_AXI_GP0_ACLK 5
ZYNQ™ oo 4 | a0 }
FCLK_CLKD m—g—]
FCLK_CLK1 pm Constant
FCLK RESETO_N p—I
ZYNQT Processing System

We will now make all necessary “External
Connections” in order to ‘wire’ our components
internally.




The connections in question are: the IIC_0 and
FCLK_CLK1 connections on the ZYNQ7 IP Block:
RECDAT, BCLK, PBLRCLK, RECLRCLK, and PBDATA on
the zybo _audio_ctrl IP block: and lastly, the dout[0:0]
pin on the Constant IP Block.

Diagram ?-0aXx
@ a X B ¢ Q ¢+ = & * C 9 & L]
rst_ps7_0_50M
ps7_0_axi_periph
siowest_sync_clk mb_reset = ¥
ext_reset_in bus_siruct_resel[0:0] = r—ii|+ S00_AXI
< awc_reset in peripheral_resel(0:0] m - ACLK 2ybo_audio_ctrl_0
= mb_debug_sys_rst | ARESETN .i.
= dom_locked peripheral_aresetn[0:0] H S00_ACLK W MO00_AXI + 4+ s_AxI
R S00_ARESETN .X.
Processor System Reset  § MOO_ACLK S _AXI_ACLK
R MOO_ARESETN S_AXI_ARESETN
processing_system?_0 AXI Interconnect ybo_audio_ctrl
DDR + {> DDR
FIXED_IO + ] [ FIXED_IO
+ xiconstant_0
- usBIND_0 + |||
M_AXI_GPO_ACLK :
ZYNQ M_AXI_GPO + i { ]
FCLK_CLKD —1—!
Constant
FCLK_RESETO_N p—
ZYNQTY Processing System

You may select each pin and right-click to select
“Make External.” Or you may Ctrl+Click each pin and
press Ctrl+T. After another layout regeneration, the
block diagram should look something like this:

Diagram ? —0aXx

@ a X M O Q s + E A C g & o
rst_ps7_0_50M processing_system7_0
slowest_sync_dlk OOR 4 ||| DDR
ext_resel_in £ FIXED_IO + ||| FIXED_IO
aux_reset_in ' G0 + |[l——>> 1ic_0_0
mb_debug_sys rst  interconnect_aresetn]20] ARESETN LEv | - USBIND_0 +
. M_AXI_GPO_ACLK
dem_locked peripheral_aresein[0:0] +— ' S00_ACLK Iﬁl MOO_AXI + Hi— - ZYNO M_AXI_GPO + [|=——
H S00_ARESETN m<m FCLK_CLKD 1
Processor System Resel MOO_ACLK FCLK_CLK1 > FCLK_CLK1.0
M00_ARESETN FOLK_RESETO_N @=—
AXI Interconnect ZYNQT Processing System
J
[
2ybo_audio_ctrl 0
J+ s BOK =[5 BCLK_O
RECDAT 0 [ REGDAT PBLRCLK m=——————————{ » PBLRCLK 0
§_AXI_ACLK RECLRCLK =——— [ RECLRCLK 0
S AXI_ARESETN PEDATA =—— [ PBDATA 0

zybo_audio_ctrl
constant_0

dout[0:0] [ dout_0[0:0]

|

Constant

That should complete the block diagram. Press F6 on
the keyboard to validate the design. You can ignore
any messages pertaining to negative DQS skew
values.

There were four critical warning messages while validating this design.

Messages

[PEU-1] Parameter : PCW_UIPARAM_DDR_DQS_TO_CLK_DELAY_0 has -~
negative value -0.050 . PS DDR interfaces might fail when entering negative DQS

skew values.

[P5U-2] Parameter : PCW_UIPARAM_DDR_DQS_TO_CLK_DELAY_1 has

negative value -0.044 . PS DDR interfaces might fail when entering negative DQS

skew values.

[P5U-3] Parameter : PCW_UIPARAM_DDR_DQS_TO_CLK_DELAY_2 has

negative value -0.035 . PS5 DDR interfaces might fail when entering negative DQS

skew values.

[PSU-4] Parameter: PCW_UIPARAM_DDR_DQS_TO_CLK_DELAY_3 has ~

Open Messages View

If this ‘Critical Messages’ window appears, click on OK
to close it.

We will now create the Block Diagram wrapper for
our design. In the Hierarchy view under BLOCK
DESIGN, right-click on the design_1.bd Design Source,
and click on “Create HDL Wrapper...”

¢ audio_example - [D:/Documents/VivadoProjects/audio_example/audio_examplexpr] - Vivado 2018.2.1
File Edt Flow Tools Repots Window Layout View  Help ck Access
= W o« B X ® @ b, B & X X

c 8 BLOCK DESIGN - design_1~

~ PROJECT MANAGER

£ Settings

Sourc x Design | Signals | Board | Platiorm| 2 _ O [5 | | AddressEditor x| Diagram
#l @ a i H 0 Q s + ¥ * C g =

Language Templates

4 IP catalog Source Node Properties.

Open File
ps7_0_axi_periph
~ IPINTEGRATOR Create HDL Wrapper. ]
Create Block Design View Instantiation Template H+ S00.AX
AcLk

Generate Output Products.

Open Block Design ARESETN lil

Reset Output Products. sooAclk  EEE My
Generate Block Design A P
MOO_ACLK

M0O_ARESETN

~  SIMULATION

RunSimulaon | fooo AXI Interconne ct
Hierarchy  IF Sou %¢  Remove File from Project

~ RTLANALYSIS
Source File Propertié

> Open Elaborated Design Disable File
design_1.d
Hierarchy Update " IECOAT 0 D
¥ SYNTHESIS ) Enabled C  Refresh Hierarchy
P Run Synthesis P Hierarchy
Location D
> Open Synthesized Design
Type: B8
~ IMPLEMENTATION Part
P Runimplementation 5
Size: 1 SetUsed n
> OpenImplemented Design
| — Edit Constraints Sets.
General  Propertis Edit Simulation Sets,
~ PROGRAM AND DEBUG
" Associate ELF Files...
¥ Generate Bitstream TclConsole M

> Open Hardware Manager

¢ Create HDL Wrapper X

Y¥ou can either add or copy the HDL wrapper file to the project. Use copy option if
you would like to modify this file.

Options

O Copy generated wrapper to allow user edits

#* LetVivado manage wrapper and auto-update

.f_"'-

Let Vivado manage the wrapper and press OK.

After some time, the wrapper will generate and the
hierarchy drop down for your design sources will
update.

Sources ? 0 & X
Q =/ s + o
v Design Sources (1)
~ @5 design_1_wrapper(STRUCTURE) (design_1_wrappervhd) (1)
W design_1_i: design_1 (design_1.bd) (1)
~ @ design_1(STRUCTURE) (design_1.vhd) (§)
i processing_system7_0: design_1_processing_system7_0_0 (design_1_pi
> @ ps7_0_axi_periph: design_1_ps7_0_axi_periph_0(STRUCTURE) (design_ 1.

ps7_0_axi_periph : design_1_ps7¥_0_axi_periph_0

rst_ps7_0 500 : design_1_rst_psy_0_50M_0 (design_1_rst ps7 0 _50M_(

¥lconstant_0: design_1_xlconstant_0_0 (design_1_xlconstant_0_0xci)
zybo_audio_ctrl_0 : design_1_zybo_audio_ctrl_0_0 (design_1_zvbo_audio_s
» Constraints
~ Simulation Sources (1)

» sim_11(1)

Hierarchy |P Sources Libraries Compile Order

We will now need to configure our Constraints file.




Under the same Sources window, click on the drop
down for Constraints, and right-click on constrs_1.
Click on “Add Sources...”

Sources ? - 0O ol X
Q= ¢+ &
> Design Sources (1)

hd Constraints

constrs 1

w Simulatic Constraint Set Properties...

’ sim_ Hierarchy Update b
* Refresh Hierarchy

IP Hierarchy 3

Edit Constraints Sets...

Edit Simulation Sets...
<+ Add Sources... Alt+A

Report IP Status

Hierarchy IP Sources Libraries Compile Order

Click on “Add or create constraints” and click on Next.

Clicking on the + Symbol will allow us to Add or
Create constraint files. We will be adding the Master
XDC file we downloaded earlier.

¢ Add Sources X

Add or Create Constraints

Specify or create constraint files for physical and timing constraint to add to your project '
Specify constraint set | &= constrs_1 (active) o
+,
AddFiles...
Create File...

Use Add Files or Create File buttons below

Add Files | | Create File

N

# Add Constraint Files X
Lookin Digilent Master viteadi, mXC [
ﬁ Zybo-Z7-Masterxdc] PERTTETS

D:Downloadsiigilent Master -

File Preview

Filename: | Zybo-Z7-Masterxdc

Files oftype: | Design Constraint Files (sdc, xdc) ~

Navigate to where you downloaded the Master
Constraints file, click on the .xdc file, ensure that
“Copy constraints files into project” is checked, and
click on Finish.

This will add a copy of the constraints file to your
local project.

Sources ? -0 a X
Q T 2 + o
e Design Sources (1)

> @5 design_1_wrapper(STRUCTURE) (design_1_wrapper.vhd) (1)
hd Constraints (1)

w constrs_1 (1)

" Zybo-Z7-Masterxdc

hd Simulation Sources (1)

> sim_11(1)

Hierarchy IF Sources Libraries Compile QOrder

We will now need to edit the constraints file. Double
click on the “Zybo-Z7-Master.xdc” in the Sources
window to edit it in Vivado.

The part we are interested in is the audio section.
Scroll down to line 44 and uncomment all the pin
declarations for the audio codec.

DD i example _limports/igilent MasterZybo-Z7-Waster xdc

Q W « » BB X N B Q

ict | PBACKAGE PIN RIS  IOSTANDARD LVCMOS33 ] [get_ports { ac_belk }1; #
ict { BACKAGE_PIN R17  IOSTANDARD LVCMOS33 ] [get ports { ac_mc:
ict | BACKAGE PIN P12  IOSTANDARD LVCMOS33 ] [get ports { ac_muten
ict { PACKAGE PIN R18  IOSTANDARD LVCMOS33 ] [get ports {
ict { PBACKAGE_PIN T19  IOSTANDARD LVCHOS33 ] [get ports
ict | BACKAGE PIN RL6  IOSTANDARD LVCMOS33 ] [gef ts
ict { PACKAGE PIN Y18  IOSTANDARD LVCMOS33 ] [get_ports
rts
rts

7 -dict { PACKAGE_PIN N18 IOSTANDARD LVCMOS33 } [get po:

{

1

{ ac_

{ ac_s
ict [ PACKAGE_PIN N17 IOSTANDARD LVCMOS33 ] [get po: {

S

Zybo-Z7-Master.xdc * ?-_0aXx

You may choose to rename all the constraint files pin
designations to match the external pins present in
our block diagram, or you can rename the external
pins in the block diagram to match the pin names in
the constraints file. For this tutorial, we will rename
the pin designations in the constraints file.




Here is our block diagram once more, and the
corresponding pins mapped in the constraints file:

? _0aX

&

Diagram

e a I ¥

processing_system?_0

ODR "> DOR
ED_10 + ||ee———{> FIXED_IO
.0 — ||l Ic_0 0
DA

M_AN_GRU_ACLK ZYNO‘ > FCLK_CLK10

= E85E8s
gepBel S 1

BCLK 0

F
FCLK ¢
FOLK RESET
ZYNQT Processing System PBLRCLK_0O
— > RECLRCLK_0
PBDATA_0
_ oboauioctl0
4 sAxI BCl
RECDAT PBLROLK
S_AXLACLK RECLRCLK
S_AX| ARESETN PEDATA

RECDAT_0 [>

deut_0[0:0]

Constant

Zybo-Z7-Master.xdc

_1imports/Digilent Master/Zybo-Z7-Master.xdc

ict [ PACKAGE PIN R19  ICSTANDARD LVCMOS33 | [get _ports [ BCLK 0 115 #I
ict { PACKAGE PIN R17  IOSIANDARD LVCMOS33 } [get_ports { FCLEK CLK]

ict [ PACKAGE PIN P15  IOSTANDARD LVCMOS33 ] [get ports [ dout 0 }

ict [ PACKAGE PIN R12  ICSTANDARD LVCMOS33 | [get _ports [ PBDATA O }1;

ict [ PACKAGE PIN T19  ICSTANDARD LVCMOS33 | [get _ports [ PBLRCLE_O }17

1 ict { PACKAGE PIN R16  IOSTANDARD LVCMOS33 } [get_ports { RECDAT 0 }];

51! set_proper ict [ PACKAGE PIN Y1i  IOSTANDARD LVCMOS33 ] [get _ports [ RECIRCIK 0 }]

: roperty -dict [ PACKAGE PIN N12  ICSTANDARD LVCMOS33 | [get _ports [ IIC_0_0_scl i

IOSTANDARD LVCMOS33 } [get_ports { IIC_0_0_sda_i

<

Note the format for the names in the constraints file
for the IIC connections (N18 and N17) as well as the
name for the mute enable pin (P18).

Save your block design and constraints file.

Before we move on, Vivado will want us to ensure all
IPs are up-to-date. We can do this with the “Report IP
Status” under “Reports” on the top of the navigation
toolbar.

¢ audio_example - [D:/Documents/VivadoProjects/audio_example/audio_examplexpr] - Vivado 2018.2.1

File Edit Flow Tools Reports  Window  Layout View  Help Quick Access
[] f o

= b - - Report|P Status " o

Flow Navigator T & sign_1*

. RS e e s AR

Upgrade any IPs that need upgrading before
continuing.

We will now run both the Synthesis and
Implementation of our design.

The Synthesis will auto-run prior to the
Implementation, so we can go ahead and click on
“Run Implementation” in the flow navigator to the
left.

* SYMNTHESIS
P Run Synthesis

» Open Synthesized Design

v IMPLEMENTATION

P Run Implementation

» OpenImplemented Design

» PROGRAM AND DEBUG

Ji Generate Bitstream

» Open Hardware Manager

¢ Missing Synthesis Results X

There is no netlist available. OK to launch synthesis first? Implementation
will automatically start when synthesis completes.

Click OK to give Vivado permission to run the
Synthesis first.

Cancel

Vivado will begin to run both the Synthesis, and then
the Implementation. This may take a while depending
on your computer hardware. You can keep track of
the progress on this process at the top right corner.

— .
Running multiple block runs  Cancel J

Default Layout W

? X
200

You may also check the “Design Runs” window at the
bottom of Vivado.

TNS WHS THS TPWS TotalPower FaledRoutes LUT FF BRAMS URAM DSP Stat Elapsed




Upon successful Implementation completion, a pop-

up window will appear. Click on “Generate Bitstream”

and click OK.

Implementation Completed >

o Implementation successfully completed.

Next
Open Implemented Design
@ Generate Bitstream

Yiew Reports

Don't show this dialog again

My Implementation/Synthesis failed!

THE LEADING CAUSE OF THE AUTHOR’S MISTAKES THAT LED TO
THE IMPLEMENTATION OR SYNTHESIS FAILURE WAS IMPROPER
PIN DESIGNATIONS IN THE CONSTRAINTS FILE. DOUBLE CHECK
YOUR CONSTRAINT FILES FOR ANY MISSPELLINGS OR
INCONSISTENCIES. CAPITALIZATION IS IMPORTANT!

The Design Runs window will notify you when the
bitstream is complete.

o &
g 3
3

Design Runs. ?_-_0ax
Q

v synth_1 (acive constrs 1 synth_design Complete! 0o 0 000 0 0 32201193:07AM 00:00:26 Vivado Synthesis Defaults (Vivado

To finish up with the hardware portion of the project,
click on “Open Implemented Design” under
“IMPLEMENTATION” in the Flow Navigator.

» SYMNTHESIS
P Run Synthesis

» Open 3Synthesized Design

¥ IMPLEMENTATION

P Run Implementation

» DOpenlmplemented Design

¥ PROGRAM AND DEBUG

Jii Generate Bitstream

» Open Hardware Manager

When the Device Layout window appears, shown
above, we are ready to hand off the project to the
SDK.

Click on File > Export > Export Hardware...

¢ audio_example - [D:y/Documents/VivadoProjects/audio_example/z

File Edit Flow Tools Reports Window Layout Wiew Hel
[} =
| Project LR - B

F
ﬂ Add Sources. .

w Close Project

:MENTED DESIGN - xc7z010clg4(

Ces Netlist b
Close Implemented Design

e
Constraints 3
isign_1_wrapper
Mets (152
Checkpoint r Leaf Cells (9
P N | design_1_i (design_1
W
Text Editor 3
Impoaort 3
Export 3 Export Hardware. .
Launch SDK Export Constraints..
iy Print... Export Pblocks...
) Export IBIS Model...
Exit
-1 - 1 Export IO Ports...
Export Bitstream File...
v RTL AMALYSIS
Export Simulation...
» Open Elaborated Design
Be sure to include the bitstream.
¢ Export Hardware ot

Export hardware platform for software
development tools. '

Include bitstream

Exportto: |« =Local to Project= e

We are now ready to move on to the SDK.




Click on File > Launch SDK to continue.

¢ audio_example - [D:/Documents/VivadoProj

Eile Edit Flow  Tools Reports Window Vlvado SDK

| Project 3 ",
Add Sources. .. flt+s IMEN . . . . . .
ﬂ 4 We will begin by creating a new Application Project.
. Close Project
Ces audio_example.sdk - C/C++ - Xilinx SDK
Close Implemented Design File Edit Mavigate Search Project Run Xilinx Window Help
- !—I_I New Alt+Shift+N > & Application Project
: i [ SPM Project
Constraints b LEENA 2=
- hoi . Open Projects from File System... M. Board Support Package
#3100, ™ Project.
Close Ctrl+W
o Med Close All Ctrl+Shiftsw &1 Source Folder
i Folder
Checkpoint b | Les save Crl+S & source File
Save As.. _ [/ Header File
1=} b | des Save Al Cirl+Shift+S | ¢ File from Template
a - R @ Class
Text Editor y Move.. 1 Other.. Ctrl+N
. . . ll . "
Import b We will be naming our SDK project “audio_example
EKD‘U I'I k New Project d X
Launch SDK Application Project @
Create a managed make application project.
oy Print... Ztrl+F
Project name: audio_e)(ample( |
Ezxit Use default location
- S— - D:\Documents\VivadoProjects\audio_example\audio_example.sdk\s Browse...
] default
OS Platform: |standalone ~
¢ Launch SDK X
Target Hardware
Hardware Platform: |design_1_wrapper_hw_platform_0 ~ | | New...
P 1 7_cortexad 0 ~
Launch software development tool. —
' Target Software
Language: @C OC++
32-bit
N/A
EKD‘U”E[I Iﬂcatlﬂn = ':\:Ll:lca.l tﬂ Prﬂject} o Board Support Package: (@ Create New | audio_example_bsp
- ' Use existing
Workspace:  » =Local to Project= e
@ < Back Next > Cancel
(o) Click on Next.
You may choose any of the available templates, but

for our tutorial, we will be starting with the “Empty
Application” template. Click on Finish.

Special note: The Vivado SDK may not play B New Project o x
. . o o Templates »
nlce Wlth Some antI-VIrus Software' lf the Create one of the available templates to generate a fully-functioning application @

project.

SDK does not open correctly or stalls out, Available Templates:

Dhrystone A blank C project.
check your AV software.

Hello World

IwlP Echo Server

IwlP TCP Perf Client

IwlIP TCP Perf Server

IwlP UDP Perf Client

IwlP UDP Perf Server

Memory Tests

OpenAMP echo-test

OpenAMP matrix multiplication Demo
OpenAMP RRC Demo

Peripheral Tests

RSA Authentication App

Zyng DRAM tests

Zyng FSBL

® < Back Next = Cancel




In the project explorer on the left, there should be
three “projects” open. Click on the drop-down arrow
for the project we created and navigate to the “src”
folder. It is here where we will be creating our C code
(.c) files and header (.h) files.

ir5 Project Explorer &3

~ [ audio_example
ki Includes

v [= SIC
Bl Iscriptid
|= README.txt
=| Xilinx.spec

(H: audio_example_bsp

(& design_1_wrapper_hw_platform_0

The files we will be using are a modified version of
the files located within the source download at the
Zyng Book website. The source code they provide has
multiple parts that are dependent on IP that are not
present in our project, thus the author has stripped
out most of what is unnecessary and has left the
relevant parts for the audio.

These files are: audio.c, audio.h, audiotest.c, and
audiotest.h

Extract the files and drag and drop it into the /src
folder for our project.

There will be a File Operation dialog box that pops up.

We will want to create a copy of the file for our
specific project.

Select how files should be imported into the project:

@ Copy files
() Link to files

Create link locations relative to: [PROJECT LOC

Configure Drag and Drop Settings...

@ oK Cancel

Click on “Copy files” and click on OK.

The Project Explorer should look similar to this:

5 Project Explorer &

+ =% audio_example
# Binaries
kY Includes
= Debug
v [ SIC
l¢| audio.c
audio.h
lg| audiotest.c
audiotesth
Tl Iscript.id
= README.txt
= Xilimspec
(8 audio_example_bsp
(¥ design_1_wrapper_hw_platform_0

Double click on “audiotest.c”, which contains our
‘main()’, to open it in the editor.

Most of the code will be commented to walk you
through the algorithms present. Though the code
includes the ‘math.h’ header file for the math
function calls involved in the program, the device
itself requires a different method for including it in
the compiler.

for(b = 8; b < SAM; b++){
double ang = pi2 * a * b / SAM;
fftR += samples[b] * cbs(ang) / 2:
fftI += samples[b] *

2 undefined reference to “cos'

} [Tnls L 3 -
Fetoutlal = sart((FFLR * ‘rremrrrmis oy

The error associated with the missing header file will
appear as “undefined reference to [math function]”

In order to properly import the math functions
required, we will have to make adjustments to the
project options.

5 Project Explorer 2 1 &|¥Y =0

+ (% audio_exz
! Include b2 ’
& Debug Go Into
v = SIC Open in New Window
lg audi 2 copy Ctrl+C
audi Paste Ctrl+V
el audi 3¢ Delete Delete
audi Source >
] Iscri Move...
EI REA Rename... F2
=| Xilir
{ audio_exa - Import..
(% design_1_ Export..
Build Project
Clean Project
Refresh F5
Close Project
Close Unrelated Projects
Build Configurations >
Run As >
Debug As >
Compare With >
Restare from Local History...
C/C++ Build Settings
T Generate Linker Script
W, Change Referenced BSP

2 Create Boot Image
Team >

Configure b |
4} Target Conne ?

Properties Alt+Enter
= Hardware e




Right click on “audio_example” in the Project Explorer
and click on “Properties” at the bottom of the list.

Navigate to “C/C++ Build -> Settings -> Tool Settings -
> ARM v7 gcc linker -> Libraries”

m Properties for audio_example O X
type filter text Settings - v
Resource
Builders
« C/C++ Build Configuration: |Debug [ Active ] ~ | Manage Configurations...

Build Vanables
Environment

Logging  Tool Settings M Devices # Build Steps Build Artifact Binary Parsers @ Error Parsers
Settings . . ~ B ARM v7 gcc assembler Libraries (-1) &
Tool Chain Editor & General

QC_H General ~ B ARM v7 gcc compiler

Project References {8 Symbols

Run/Debug Settings  Wamings

(2 Optimization
= Debugging
2 Profiling
# Directories
& Miscellaneous
~ (& Inferred Options
(& Software Platform
 Processor Options
~ & ARM v7 gec linker
# General
& Libraries Library search path (-L) ]
# Miscellaneous
= Linker Script
~ (& Inferred Options
(& Software Platform
 Processor Options
& ARM v7 Print Size

Restore Defaults Apply
@ Cancel

In the bar to the right of “Libraries (-1)” click on
“Add...”

B8 Enter Value x

Libraries (-1)

[

| oK Cancel

Type the letter “m” and press OK.

Click on “Apply” and “OK” to close the properties
window.

The project should rebuild itself with the math library
now included, removing all previous errors present in
the code. If the project did not rebuild, you can
simply hit ‘Ctrl+S’” with the “audiotest.c” file window
active to save the file and rebuild the project.

5 Project Explorer &
w % audio_example
i Binaries
k! Includes
= Debug

v = SIC
l¢] audio.c
audio.h
le| audiotest.c
audiotesth

Tl Iscript.Id
E README.txt
=| Xilinx.spec
(H: audio_example_bsp
(& design_1_wrapper_hw_platform_0

We will now run the code on the Zybo FPGA.

First, ensure that the FPGA is connected to your
computer and that all jumpers are set properly (JTAG
on JP5, appropriate power source next to the power
switch). Turn on the FPGA device. The red ‘PGOOD’
light (LD13) should turn on.

In the SDK, click on the Program FPGA button on the
top menu.

DB E A

Program FPGA l'

The default options should be correct. Reference your
settings to the image below. Click on “Program” at
the bottom of the window.

Program FPGA X

24

Program FPGA

Specify the bitstream and the ELF files that reside in BRAM memory

Hardware Configuration

Hardware Platform: design_1_wrapper_hw_platform_0 b

Connection: Local W New

Device: | Auto Detect | Select...

Bitstream: | design_1_wrapper.bit ‘ Search..| Browse.

[ ] Partial Bitstream
BMM/MMI File: Search...| | Browse..

Software Configuration

Processor ELF/MEM File to Initialize in Block RAM

v
@ Program Cancel




If the FPGA has been properly programmed, the
green DONE light (LD12) should light up.

We are now ready to launch our software on the
FPGA.

First, let us open the SDK Terminal Window to get the
messages from the FPGA.

[RLTLT LY L LY R J B LA LA I

Window Help
A New Window G ow -
i Editor >
|- Appearance 5 SyStem.mss audiotest.c
Show View > C/C++ Projects
Perspective > B Console Alt+5hift+Q, C
o ™ Documents
Navigation ’ £ Include Browser I
Preferences @ Make Target B
co = Navigator ]
€0 §= Qutline Alt+Shift+Q, 0 3.

# Problem Details

€0 [l Problems Alt+Shift+Q, X "

;: [t5 Project Explorer i

] Properties l
co ¥ Search Alt+Shift+Q, S |
co ¥ Tasks 5
co Other... Alt+Shift+Q, Q@ £

Navigate to “Window -> Show View -> Other...” or
press Alt+Shift+Q, then Q, to open the Show View
window. Under “Terminal”, double click on
“Terminal.”

@ Show View 0 X

type filter text

= LTTng ~
= Make
= Network Tracing
= Oprofile
= Profiling
= Remote Systems
= Team
~ = Terminal
& Terminal
= Tracing
= Xilinx

oK Cancel

This should open the Terminal window at the bottom
of your screen. Click on the settings button to adjust
the settings of the Terminal window.

v~ =0 [ESDKlog & Terminal 1 12 NrBaEELrEyx =0
Serial: (COMB, 115200, 8, 1, None, None - CLOSED) - Encoding: (ISO-8859-1)

Upon changing the connection type to Serial, the
settings shown in the image below should be the
default settings for the Terminal.

Terminal Settings X

View Settings:

View Title: | Terminal 1

Encoding: | 150-8859-1 w

Connection Type:

Serial %
Settings:

Port: v
Baud Rate: 115200 b
Data Bits: 8 ~
Stop Bits: 1 »
Parity: Mone ~
Flow Control: |None ~

Timeout (sec): | 5

OK Cancel

Of note is the Port option. The Zybo FPGA
opens two communication ports to the
computer. The first port (COM3, COM5,
etc.) is used to program the FPGA. The

second port (COM4, COMe6, etc.) is used to

communicate with the software running

on the device. On the author’s computer,
COME6 is the port used to communicate
with the software running on the Zybo.

Pressing OK on the Terminal Settings should
automatically begin the connection with the FPGA.




Now that the FPGA is programmed with the bitstream It is advised to use a different Terminal window to

and the communication terminal is connected, we view the project’s outputs. The SDK terminal window
will be able to see if our program is running properly. is great for debugging purposes, but it is lacking in
For this program to work, it should be noted that a versatility. TeraTerm is a free program that can also
microphone should be attached to the Zybo FPGA’s pick up the output from the Zybo upon proper
pink MIC IN connection. configuration.
Right click again on the “audio_example” project in Due to the nature of the code implemented on the
the Project Explorer. We will want to Launch this Zybo, it is necessary to play chords or complex note
project on the Hardware. Navigate to “Run As -> 4 combinations to receive an output that differs from
Launch on Hardware (GDB)” “nothing detected.” A guitar, or playing a song to the
microphone should have it pick up different readings.
R e | S udoester The core of the work with audio on the Zybo FPGA
* Binaries New 5 #include "audiotest.h" . o
S Goo Hinclude <nth-> will stem from collecting the samples from the on-
@ Debug Open in New Window const int SAM = 2048; //N number ¢ . . .
T B o) ® o uec || constnevn o8 00 board SSM2603 Audio Codec; all of the configuration
[b audio. _ REE ShkY const double reffE ]_: {16. J, d X,J_ .O; o o . .
B ey % Dot = T e ot for the codec is found in the audio.c file. The
[n audiot — ;znsin:.:x nuz e:ic ords = H Ongr_o;— ) )
e — R | dowie smeoth <7 exponentis audiotest.c code is the author’s example on
=) Xilinxs 1 Import.. const double maw = 1.0; [/weight for . . .
B s o] 4 Export. const detble m - 1.0; ueight for processing the samples using complex algorithms.
(& design_1_wr Build Project const double dw = 1.0; //weight for
Clean Project double scoreWS = 0.0; //initialize
Benesh S double max = 0.0;
Close Project long unsigned :i.n;: rollavg = 8;
Close Unrelated Projects int currentState = @; //State \e_
Build Configurations || it revastate - 01 [ Istate vall
Run As > % 1 Launch on Hardware (Syst‘em Debugger) N )
T A > Ed 2 Start Performance Analysis o . .
Compme i B itaunc:onﬂar:wareg%ge)mDebuggeronaww : This tutorial thus far has been on programming the
Restore from Local History... i‘* SHLLE &l L Wére_ . . .
/Cor Build Settings e | Zybo FPGA to process audio signals. When it comes
T Generate Linker Script OS] el
S ;.a.f'!ii.?ii”iilil"m T time to finalize your project, loading your software to
Team > < o
TN oo | — boot off of an SD card will be necessary to remove
 Hordware 0P e || Progrem FPea the restrictions of having to connect to a host
computer running the SDK. We will now briefly cover
If everything is working as expected, then the the SD Boot process.
Terminal window should begin to display the project’s
outputs.
E]SDK Log & Terminal 1 52 N EEE @8- % =0
Serial: (COM®, 115200, 8, 1, None, None - CLOSED) - Encoding: (1ISO-8859-1)
Gmaj ~
Gmaj
Gmaj
Gmaj
Emin
Emin
Emin
Emin v

< >




SD Boot

Booting from the SD card will be necessary to remove
the need for a host computer.

We will begin in SDK by creating a new First Stage
Boot Loader application project.

Navigate to “File -> New -> Application Project”
We will name ours “fsbl_example.” The default
options will suffice.

Click on Next, and choose Zynq FSBL

New Project a X
Templates ﬁ
7
Create one of the available templates to generate a fully-functioning application
project.

Available Templates:

Dhrystone First Stage Bootloader (FSBL) for Zynag. The
Empty Application FSBL configures the FPGA with HW bit stream
Hello Waorld (if it exists) and loads the Operating System
IwIP Echo Server (05) Image or Standalone (SA) Image or 2nd
IwlP TCP Perf Client Stage Boot Loader image from the

lwlP TCP Perf Server non-volatile memory (NAND/NOR/QSPI) to
IwIP UDP Perf Client RAM (DDR) and starts executing it. It

IwlIP UDP Perf Server supports multiple partitions, and each
Memory Tests partition can be a code image or a bit
OpenAMP echo-test stream.

OpenAMP matrix multiplication Demo
OpenAMP RPC Demo

Peripheral Tests

RSA Authentication App

Zyng DRAM tests

Zyng FSBL
'f?:' < Back Next = Cancel

Click on Finish

The SDK will create the first stage boot loader based
off of the bitstream that was handed off by the
Vivado software.

The FSBL does not need to be edited.

Right click on your project “audio_example” and
choose “Create Boot Image.”

Pay special attention to the output path, as we will
have to navigate there to find the BOOT.bin file that
will be copied onto the micro SD card.

Create Boot Image P
Creates Zynq Boot Image in .bin format from given FSBL elf and partition files in specified output folder. @

Architecture: | Zyng ~
@ Create new BIF file O Import from existing BIF file

Basic  Security

Output BIF file path: ‘ D:\Do(umemts\\livadoProjetts\audic_example\audio_example‘sdk\audio_example\bootimage\audio_examplebi‘ Browse...

UDF data: ‘ ‘ Browse...
Isplit Output format: |BIN
Output path: ‘ DADocuments\VivadoProjects\audio_example\audio_example.sdk\audio_example\bootimage\BOOT.bin ‘ Browse...

Boot image partitions

= path Encrypted  Au
botloader) DADocuments\VivadoProjects\audio_example\audio_example.sdk\fsbl_example\Debug\fsbl_example.elf none no
Documents\VivadoProjects\audio_example\audio_example.sdk\design_1_wrapper_hw_platform_O\design_1_wrapper.bit none no
Documents\VivadoProjects\audio_example\audio_example.sdk\audio_example\Debug\audio_example.elf none no
Add
Delete
Edit
Up |
Down
< >
'/?:' Preview BIF Changes Create Image Cancel

Under Boot image partitions, ensure that there are
three files. The order in which they are listed is also
important. The topmost file should be the
“fsbl_example.elf” bootloader file. The second should
be the bitstream wrapper for the project. The last will
be the “audio_example.elf” file associated with the
project we created.

Click on “Create Image” and the SDK will create the
Boot image.

Local Disk (D:) » Documents > VivadoProjects » audio_example > audio_example.sdk » audio_example > bootimage

~

“ MName Date modified Type Size

% audio_example.bif 6/6/2019 14:06 PowerlSO File T1KB

BOOT.bin 6/6/2019 14.06 PowerlS0 File 2,217 KB

Navigating to the folder where the output was
created, we should have two files created. The “.bif’
file and the ‘.bin’ file.

Copying the BOOT.bin file to an SD card, inserting the
SD card to the FPGA, setting the jumper from JTAG to
SD, and powering the FPGA should automatically run
the project we uploaded into it upon booting. Using
the same programming cable to connect to a PC and
connecting to the FPGA through a terminal should
allow us to read the outputs of the device.

This concludes our brief tutorial on booting from an
SD card.




